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Introduction
The SimCity 2000 Urban Renewal Kit—a.k.a. SCURK—is the
ultimate utility for the ultimate city simulator. Building and
editing cities and terrain for your Sims was only the
beginning. Now you can:

• Build a SimCity 2000 city from scratch, or modify any
pre-built city your way, without any money, population,
time or developmental constraints. Put buildings, roads,
subways...you name it...anywhere, any time, for any
reason. 

• Enhance, modify, and otherwise embellish the original
SimCity 2000 artwork, and even design your own. 

• Mix and match the original SimCity 2000 buildings with
your own art to create custom object sets that you can
load into SimCity 2000.

• Print out your city in any of three sizes, above or below
ground, and showing (or not) any layers you choose.

Still not enough for you? Well then, as an added bonus, the
talented folks in our art department have created an entirely
new, futuristic set of graphics for your enjoyment and editing
pleasure. 

SCURK is an add-on to SimCity 2000. It won’t install or work if
you don’t have SimCity 2000. You’ll have a lot more fun with
SCURK if you are already familiar with SimCity 2000, so if you
haven’t played SimCity 2000, set this manual down and go
play. Once you have a feel for the game, you’ll have a better
feel for designing buildings and cities in SCURK.

SCURK and 
SimCity 2000
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Not only will SCURK help you get more out of SimCity 2000,
it’ll help you get more out of a number of other yet-to-be-
released games as well. SCURK will work with and enhance a
number of future Maxis games. You’ll be able to use SCURK
to create city raceways for driving simulations, targets and
obstacle courses for flying simulations, and the playfields for
games that...well, you’ll just have to wait and see.

When you install SCURK, all the necessary changes are made
to your copy of SimCity 2000 so you can use the new
graphics we provide or the ones you create. See the SimCity
2000 Special Edition Quick-Start Guide for complete
instructions for installing and starting SCURK on your
computer.

Some of the windows on your computer, and some of the
object names, may be a little different than how they appear
in this manual. This won’t have any effect at all on how the
utilities and objects work.

Even though there is a great deal of similarity in how SKURK
utilities function on different computers, there are a few
differences. Where these differences are significant, the
instructions are grouped by that particular computer.

Using Your
Graphics

SCURK and
Future Maxis

Computer
Games

Some 
(Really Small)

Warnings
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After you’ve clicked your way through the title screens,
you’ll be at the riveting SCURK Main Screen. This is where
you access each of the three SCURK utilities. Each utility is
described under its button.

Click on a button to start that utility.

FILE MENU 
About...scrolls important credits
and information. It’s worth the
reading. Honest.

Quit ends SCURK and sends you
back to DOS.

UTILITIES MENU
Paint the Town starts the Paint the
Town utility. 

Pick & Copy starts the Pick & Copy
utility. 

Place & Print starts the Place & Print utility. 

SOUND MENU
Enabled toggles all sound effects On and Off.

Note: Keyboard shortcuts for menu options are
displayed in the menus.

The SCURK DOS
Main Screen

Main Screen Menus
Menu Bar

Big, pretty logo

Utility Buttons

DOS
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SCURK consists of three utilities, each in its own window. To
activate a utility, either click on it, or select it in the Window
menu.

Paint the Town is a specialized paint program that lets you
create new graphics or enhance old ones from either the

original or Future City set.

Pick & Copy lets you mix
and match different
graphics.

Place & Print lets you
design, modify, plan, model
or otherwise shape a city,
and print it out in three
different sizes.

Before jumping into the program, here are some helpful
definitions:

Objects—Objects are things that appear in SimCity 2000 that
can be modified in SCURK. They include buildings, roads,
rubble, animated objects and a few other things.

Object Set—An Object Set is a file containing one or more
objects. In SCURK, you are able to copy objects from set to
set.

Working Object Set—The Working Object Set is the Object
Set that you are currently modifying. In Windows and the
Working Object Set is available to all three utilities, and
changes you make to the Working Set in one utility are
immediately reflected in the other utilities.

SCURK in
Windows 

Place & Print
Pick & Copy
Paint the Town

WINDOWS 

Common
Definit ions
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Paint the Town is a specialized paint program that lets you
create your own graphics for the objects (buildings, etc.) in
SimCity 2000. You can create artwork from scratch or you
can start with the original or Future City sets and modify them.

Note: Changing the look of the objects does not in any
way change the way the SimCity 2000 simulation
works or the game plays. This means you can get as
weird and wild as you want with your object designs
and it’ll always work. In the words of the Immortal
Bard, “A Braun Llama Dome by any other visual
representation would still smell as sweet.” (At least to
your Sims.)

Here are a couple more useful definitions for understanding
Paint the Town:

Tiles—A tile is a measurement of area in SimCity 2000. Tiles
are the little squares on the ground.

Base Size—Each object has a pre-set, unchangeable base
size that limits its width and depth. Some objects have a
base size of 1 x 1 tile, others are 2 x 2, a few are 3 x 3, and the
biggest ones are 4 x 4. Even the animated, moving objects
that don’t sit on the ground (like planes and ships) are
limited to their base tile size. 

Paint the
Town

Object

Tiles

Base Size

General
Information
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When the Paint the Town utility window is open you can
create brand new graphics for SimCity 2000 from scratch, or
load in an existing set to modify.

Toolbox

Information Line

Menu Bar

Drawing Area

Object Selector

View Windows

Active Object 
and its Base Size

Color Palette

Texture Palette

Round Brushes

Square Brushes

Current Color

DOS

WINDOWS

Toolbox

Status AreaMenu Bar

Active Object Group

Drawing Area

Object Selector

View Windows

Active Object and its Base Size

Palettes
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Paint the Town works like most computer paint programs,
with a couple of special tools to make it easier to draw in the
proper perspective for SimCity 2000. The basic process is to
choose the tool you want to use from the Toolbox, choose
the color you want to use from the palette, then paint in the
Drawing Area. Your work will simultaneously be displayed in
three SimCity 2000 zoom sizes.

If you are familiar with other computer paint programs,
you’ll master Paint the Town in no time. If not, then read
through this section of the manual and play through the
tutorial, and you’ll master it in almost no time.

Free Drawing Tool—Turns your cursor into a free-style
drawing tool. Click or click and drag the mouse in the
Drawing Area to use it. In DOS and Windows, while active
(and within the Drawing Area), the cursor is a pencil. The
size of dots and lines that this tool draws depends on the
brush size. 

The Tools

Box

Right Wall

Eraser

Line

Left Wall

Fill

Free Drawing Tool

Diamond

Circle

Copy Paste

Zoom In

Eyedropper (Color Picker)

Zoom Out

(DOS) Copy/Import
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Eraser—Turns your cursor into an eraser. Click or click and
drag the mouse in the Drawing Area to use it. In DOS and
Windows while active (and within the Drawing Area), the
cursor is an eraser. The area that this tool erases depends on
the brush size. 

Line—Draws a straight line at any angle. Click and hold to
begin the line, drag the mouse to define the line, then release
the mouse button to draw the line. While active (and within
the Drawing Area), the cursor is a crosshair. The thickness of
the line depends on the brush size. 

Diamond—Draws diamond shapes. Click and hold to choose
one corner of the diamond, drag the mouse until the
diamond is the size you want, then release the mouse button.
While active (and within the Drawing Area), the cursor is a
crosshair. The thickness of the diamond’s outline depends
on the brush size. When this button is active, click it again to
open a submenu that lets you choose between a hollow
diamond and a filled diamond.

Left Wall—Draws parallelograms that make it easy to draw
left walls of buildings in the proper perspective for SimCity
2000. Of course, you can use it for things other than left walls
if you choose. Click and hold to choose one corner of the
wall, drag the mouse until the wall is the size you want, then
release the mouse button. While active (and within the
Drawing Area), the cursor is a crosshair. The thickness of the
wall’s outline depends on the brush size. When this button is
active, click it again to open a submenu that lets you choose
between a hollow left wall and a filled left wall.

Right Wall—Draws parallelograms that make it easy to draw
right walls of buildings in the proper perspective for SimCity
2000. Naturally, you can use it for things other than right
walls if you choose. Click and hold to choose one corner of
the wall, drag the mouse until the wall is the size you want,

DOS Windows
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then release the mouse button. While active (and within the
Drawing Area), the cursor is a crosshair. The thickness of the
wall’s outline depends on the brush size. When this button is
active, click it again to open a submenu that lets you choose
between a hollow right wall and a filled right wall.

Circle—Draws circles and ellipses. Click and drag the mouse
until the circle is the size—and shape—you want, then
release the mouse button. While active (and within the
Drawing Area), the cursor is a crosshair. The thickness of the
circle’s outline depends on the brush size. When this button
is active, click it again to open a submenu that lets you
choose between a hollow circle and a filled circle.

Box—Draws squares and rectangles. Click and drag the
mouse until the box is the size—and shape—you want, then
release the mouse button. While active (and within the
Drawing Area), the cursor is a crosshair. The thickness of the
box’s outline depends on the brush size. When this button is
active, click it again to open a submenu that lets you choose
between a hollow box and a filled box.

Fill—Fills an area with the selected color, cycle, or texture. It
begins where you click in the Drawing Area and fills in all
directions until it comes to another color. Fill considers each
color of a color cycle pattern to be a different color, so filling
over color cycled areas isn’t very effective. While active (and
within the Drawing Area), the cursor is a crosshair. 

Eyedropper (Color Picker)—Lets you set the brush color by
selecting a color in the Drawing Area (so you don’t have to
find the color in the palette). Click on the color you want.
While active (and within the Drawing Area), the cursor is a
crosshair. 

DOS Windows
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Zoom Out—Lets you “step back” from your drawing in the
Drawing Area for a big picture look at your work. There are
four zoom levels. These are zoom levels in addition to the
zoom levels of SimCity 2000. They exist to make drawing
easier, and do not affect the actual artwork.

Zoom In—Moves you up close in the Drawing Area for
those dot-by-dot corrections which can make all the
difference between good work and great art. There are four
levels. These are zoom levels in addition to the zoom levels
that appear in SimCity 2000. They exist to make drawing
easier, and do not affect the actual artwork.

Copy—Lets you make a copy of any portion of any object in
the Drawing Area. Click and drag the cursor to outline the
part of the object you want to copy. When you release the
mouse button, your cursor becomes a “brush” composed of
the copy, and SCURK automatically changes to the Paste
tool. Click to paste the copy, or click and drag to paint with
the brush. While active (and within the Drawing Area), the
cursor is a crosshair until something is copied. You can
manipulate the copy (rotate or flip) with tools in the Edit
menu before you paste it. The copy is kept on the clipboard
until you copy something else. 

Paste—Lets you paste what you have copied (from the
Drawing Area or to the clipboard from another program)
into the Drawing Area. It is automatically selected by SCURK
right after you copy something with the Copy tool. The copy
is kept in memory until you copy something else, so you can
use different tools and even load another Object Set, then
return to Paste and still have the copy to paste.
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The DOS Copy tool can be switched between its normal copy
function and a special Copy Import function. When you im-
port a PCX file (see the section on the File menu below), the
Copy tool automatically becomes the Copy PCX tool. As long
as a PCX file is loaded in, you can click and hold or double-
click on the Copy button to open a submenu that lets you
change back and forth between normal Copy and Copy PCX.

Copy Import—Lets you copy parts of imported PCX graphics
so you can paste them into your work in the Drawing Area.
Copy Import is only available if you have imported a graphic.
Click on the Copy Import button to open the Import screen.
Copy Import functions in the Import screen the same way as
Copy works in the Drawing Area. As soon as you copy
something in the Import screen, you are automatically
returned to the Drawing Area with the Paste tool activated.
See the section on the Import screen later in this manual for
more details. Click and hold or double-click on the Copy
Import button to open a submenu that lets you change back
and forth between normal Copy and Copy Import.

DOS Notes on the
Copy Tool
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Brush Color—Shows the current color and texture pattern of
the brush.

Brush Size—Lets you set the size and/or
thickness of the dots, lines and shapes you draw
(or erase) to a one-, two-, three-, four-, five- or six-
pixel square. Windows users also have round
brushes which are four- and five-pixels in size.
Brush Size affects the free drawing tool, eraser
tool, line tool, and all the shape tools. Larger
brush sizes soften the corners of the Diamond,
Left Wall and Right Wall shapes.

Texture Palette—Lets you choose from a
selection of pre-designed texture patterns. Click
on a texture to chose it. A red square marks the
active texture. In DOS, the solid texture, at the

top-left of the texture palette, uses only the
foreground (f) color. The three textures
across the top of the Windows palette use
solid colors. The first one (white) uses only
the foreground (f) color. The second one
(gray) mixes the foreground and background
(b) colors together. The third one (black)
uses only the background color. All other
textures under all platforms use both
foreground and background colors to create
their patterns.

Color Palette—Shows the electronic “paints”
available for your works of art. Click on a
color with the left mouse button to select a
foreground color, and the right mouse button

The Palettes

Texture Palette

Color Palette

Brush Color

Brush Size 

Texture
Palette

Color Cycle
Display

Slider Bars

Brush Color

Sample Color Palette

Brush Size

DOS

WINDOWS
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to select a background color. The color cycle patterns are at
the end of this palette. 

Color Cycle Display—Shows the currently accessible color
cycle pattern. Double-click on the Color Cycle Display to
open the Color Cycle Palette. (You can also open it with the
Cycle Palette item in the Windows menu.) This palette lets
you choose from eleven pre-set color cycle patterns. The No
Disp option at the end of the palette turns off the cycle
display. (It doesn’t stop the colors from cycling, just the
display which can get on some people’s nerves.)

Sample Color Palette—Displays colors which are near each
other in the full palette. Use the Slider bar to scroll through
all the colors of the palette. Click and hold or double-click on
any color to display the entire palette of colors at once. (You
can also open it with the Palette item in the Windows menu.)
Click on a color to select that color (in either the Sample or
Full Color Palette). Use the left mouse button to select the
foreground color, and the right mouse button to set the
background color. Background colors can only be used with
textures, not with solid colors.

Note: See Appendix 2 for more information on colors,
palettes and color cycling.

The Drawing Area is where you modify our graphics and
create your own. Objects in the Drawing Area are displayed
larger than they’ll be in SimCity 2000, so you can more easily
see the details while drawing them. The display size can be
adjusted with the Zoom In and Zoom Out tools in the
Toolbox.

Page 13

The Drawing
Area

DOS Notes on
Palettes
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BASE SIZE, HEIGHT LIMIT 
AND THE CLIP REGION
Each object (even when it is blank)
has a set base size. Base sizes can be
one, two, three or four tiles square.
The Drawing Area always displays a
4 x 4 base, but you can’t always use
the whole base—only as much of the
base as the object you are drawing
or editing has. Base sizes cannot be
changed. The base size is displayed
in the Paint the Town title bar, along
with the object name.

Each object also has a height limit, which is the top of the
Drawing Area. No object can extend beyond the top of the
Drawing Area.

SCURK will instantly and automatically erase (clip) anything
you draw or paste outside an object’s base size or above the
Drawing Area.

An easy way to keep track of both the base size and the
height limit while painting an object is to turn on the Clip
Region or clip grid display. 

This will show a grid that defines the part of
the Drawing Area that can be used for a
particular object. It is always active, but is
only displayed when you want to see it. To
turn on the Clip Region display, open the
Options menu and select Show Clip Region.
Select it again to turn it off.

Scroll Bar

Object Name
and Base Size

Visible Drawing
Area

A blank “Home” object
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The view windows show the entire Drawing Area, and
display what your finished products will look like in three
SimCity 2000 zoom levels. These windows are for display
only. You can’t draw in them.

Note: You only have to draw each object once and SCURK
automatically converts it to all three sizes for you. 

If you want to edit existing graphics, open the File menu,
select Open... then choose the existing graphics set you
want to edit. (In Windows, the original objects are loaded by
default.) If you want to start your own graphics set from
scratch, open the File menu and select New. (In DOS, a new
set is loaded by default.)

The Paint the Town Object Selector is where you choose the
object you want to work on in the Drawing Area. Here’s how
to use it:

Object
Selector

The View
Windows

DOS WINDOWS
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Open the Object Group menu and choose a group of objects
(the default is Residential). 

Click on either arrow in the Object Selector until you see the
object you want to edit. (If you hear a little “bell” when you
click an arrow, it means you are at one end of a group of
objects. Simply click the other arrow. In DOS the objects
loop around and repeat endlessly).

Click on the object you want to edit to load it into the
Drawing Area, ready for creative talents to go wild.

In Windows, if you want to edit a different set of objects,
open the File menu, select Load..., then choose Working
Object Set. A dialog box will let you choose the object set
you want to edit.

The Windows Information Line provides a brief explanation
of the highlighted Menu item. It also displays the coordinates
of the drawing tool within the Drawing Area. Position 0/0 is
the top-left corner and 128/256 is the bottom-right corner of
the Drawing Area, regardless of base tile size.

FILE MENU

New—Creates a new, unnamed, blank graphics set.

Open...—Lets you load a previously saved graphics set for
editing.

Save—Saves the current graphics set under the file name
shown in the title bar.

Save As...—Lets you change the name and path of a graphics
set as you save it.

The Paint the
Town Menu Bar

DOS

Windows
Information Line
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Import PCX...—Loads a PCX format graphic created by
another graphic program so you can copy a portion of it and
paste it into the Drawing Area. See the DOS Import Screen
section in this manual for more information.

Export PCX...—Saves the object in the Drawing Area as a
PCX file that other graphics programs can use. Export PCX...
only exports the one object in the Drawing Area, not the
whole graphics file.

Main Screen—Returns you to the SCURK Main Screen.

Quit—Returns you to the DOS prompt.

PREFERENCES MENU
Clip Grid—When selected, displays the clip grid for the
object currently in the drawing area.

Color Cycle—When selected, displays the changing color
cycle patterns in the palette and in the drawing area. When
off, no color cycling is displayed (sometimes those flashing
colors can get annoying).

WINDOWS MENU
Palette—Opens the Color Palette.

Cycle Palette—Displays the Color Cycle Palette.

Import Screen—Displays an imported PCX graphic. If you
have not imported a graphic, this option is ghosted and
unavailable.

STATUS AREA
This area displays any or all of the following references:

IMPORT—Indicates that PCX file has been imported and is
available for use. The Copy Import tool and the Import
Screen are also available.
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COPY—Indicates that you have copied something with the
Copy tool or Copy Import tool, and can modify it with
commands in the Edit menu and paste it into the Drawing
Area.

X: & Y:—Shows the coordinates of the drawing tool within
the Drawing Area. Position 0/0 is the top-left and 128/256 is
the bottom-right corner of the Drawing Area, regardless of
base tile size, height limit or Clip Grid.

File Size—Displays the size of the currently loaded
graphics set. The size of the graphics set depends on the
sizes—especially the heights—of the buildings. If you keep
your buildings small and short, the graphics sets will be
small. Graphics sets can be quite large. The original set is
about 1 MB, and you can make your own sets much larger.
Saving a lot a graphics sets can eat up a lot of up disk space.

DOS IMPORT SCREEN
The Import screen appears when you
click on the Copy Import tool or
select Import Screen from the
Windows menu.

Click and drag the cursor over the
part of the PCX graphic that you want
to copy. When you release the mouse
button, you will return to the Drawing
Area, ready to paste the copy (or
rotate or flip it with the Edit menu
tools).

You can outline a large chunk of the
PCX file that might be too big to fit
into the Drawing Area. When this
happens, anything outside of the Clip
Grid will be erased.Imported Graphic

Background Color IndicatorInstruction Bar
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The Background Color Indicator shows which color is
considered to be background. You select the background
color by clicking the cursor on that color with the right
mouse button.

The background color will be transparent when you return
to the Drawing Area, letting you automatically trim an object
out of its background as you copy it. (This is not the same as
the “background” color of the color palette.)

Colors will not cycle in the Import screen, but any colors
which correspond to a color cycle will cycle once pasted into
the Drawing Area.

To leave the Import screen without copying anything, just
click—don’t click and drag—in the screen.

Two PCX files, Sample1.pcx and Sample2.pcx are included with
SCURK. These files have different building parts, patterns and
textures that you can copy and use in your own creations.

FILE MENU
Since the SCURK utilities share the same information, they
share many of the same menus and menu functions. Each
utility also has some menu items which are unique to that
utility. Here’s a list of the Paint the Town menu under
Windows  items and what they do:

Load has three submenu items:

City...—Loads a previously saved city terrain for use in
Place & Print.

Source Object Set...—Loads a source object set for use
in Pick & Copy.

Working Object Set...—Loads the Working Object Set
used in all three SCURK utilities.

Windows
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Save has two submenu items:

City—Saves the city terrain used by Place & Print under
its current name and path.

Working Object Set—Saves the Working Object Set
under its current name and path.

Save As has two submenu items:

City...—Lets you change the name or path (or both) of
the city terrain used by Place & Print.

Working Object Set...—Lets you change the name or
path (or both) of the Working Object Set.

New has two submenu items:

City—Loads an unnamed, blank, flat city terrain for use
in Place & Print.

Working Object Set—Loads a clean, unblemished copy
of the original object set as the Working Object Set.

Export BMP File...—Under Windows, Exports the Object in
the Paint the Town Drawing Area as a BMP file.

Print Setup...—Opens a dialog box which allows you to
change certain aspects of how your printer will function.

Print City...—Opens a dialog box which allows you to print
some or all of the city which is loaded in Place & Print.

Exit—Closes SCURK (after prompting you to save any
changes you made).

OPTIONS MENU 

Grid Settings...—Lets you set how fine your drawing grid will
be so you can more easily line up shapes with each other in
the drawing area.
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Snap to Grid—Forces the shapes you draw to line up along
the grid pattern.

Show Grid—Toggles the Snap to Grid pattern so you can see
how your objects will line up when you draw them. This grid is
for display only. It won’t become part of an object’s artwork.

Show Clip Region—When selected, displays the Clip Region
for the object currently in the Drawing Area.

Cycle Colors—Toggles the color cycling on and off, which
can make it easier to use for animation. (Sometimes those
flashing colors can get annoying). This affects color cycling
only in Paint the Town.

Increment Cycle—Lets you “step through” the Paint the
Town color cycle patterns for easier animation. This affects
color cycling only in Paint the Town. You can use it only
when color cycling is turned off.

Sound Toggle—Toggles the sounds for SCURK tools and
sound effects of the objects. This only affects objects when
they are in SCURK. 

WINDOW MENU
Cascade—Overlaps the SCURK utility windows. Click the title
bar of the utility you wish to use to activate.

Paint the Town—Activates the Paint the Town utility.

Pick & Copy—Activates the Pick & Copy utility.

Place & Print—Activates the Place & Print utility.

EDIT MENU

Undo—Removes the result of the most recent mouse action
from the Drawing Area.

Copy—Lets you make a copy of any portion of an object in
the Drawing Area.

For Al l  Computers
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Paste—Lets you paste what you have copied (either with the
Copy tool or to the clipboard) into the Drawing Area.

Clear—Erases the contents of the Drawing Area and leaves
clean ground and clear sky.

Revert—Returns the object in the Drawing Area to the state
it was in when you brought it into the Drawing Area. Revert
only works on one object at a time. You must use it before
you change objects—no “go backs.”

Rotate—Rotates what you have copied to the clipboard 90
degrees counter-clockwise. Select it again for an additional
90-degree rotation. This item is “ghosted” if the Paste tool is
not selected or if the clipboard is empty.

Flip Horiz—Flips what you have copied to the clipboard 180
degrees horizontally. (Left becomes Right.) This item is
“ghosted” if the Paste tool is not selected or if the clipboard
is empty. In DOS this item is Flip Copy of Horiz.

Flip Vert—Flips what you have copied to the clipboard 180
degrees vertically. (Top becomes Bottom.) This item is
“ghosted” if the Paste tool is not selected or if the clipboard
is empty.  In DOS this item is Flip Copy Vert.

Rename—Opens a dialog box that allows you to change the
name of an object. (This is the name that appears in the
query box of SimCity 2000.)

Revert Name—Returns the original name of an object to that
object.

OBJECT GROUP MENU
This menu lets you select a group of objects from the
currently loaded object set. The selected group will appear
in the Object Selector. Load any single group at a time, or an
entire object with the All option.

Undo or Revert? Undo
removes the results of
only the most recent
mouse click. For
example, if you were to
draw a circle, Undo
would remove it. If you
draw a circle and then
a box, Undo would
remove the box. Revert
removes work you have
done since you brought
an object into the
Drawing Area. For
example, if you draw a
circle and then a box,
Revert removes both of
them. If you draw
something and then
load another object into
the Drawing Area, and
then load the first
object again, Revert
does not remove what
you drew previously.
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OBJECTS YOU CAN’T MODIFY
The following objects cannot be altered in SCURK:

• Roads • Highways

• Onramps • Tunnels

• Rails • Subways

• Trains • Sub-to-Rail Connectors

• Power Lines • Water Pipes

• Bridges • Wire Crossings

• Water Tiles • Ground Tiles

• Hillside Tiles • Signs

• The Alien • Small Parks

• Small Boats • Helicopters

• Zone Indicator Colors • Police, Fire and Military 

• Airport Runways Dispatch Icons

IMPORTING GRAPHICS UNDER WINDOWS
You can import graphics into Paint the Town. If you can load
them (or draw them) in any graphics program and copy
them to the clipboard, you can paste them into the Paint the
Town drawing area.

IMPORTED GRAPHICS AND COLOR
Palettes are tricky things, especially when you import
graphics from other programs. Both SimCity 2000 and SCURK
have a set 256-color palette that reserves a number of places
for color cycling. This palette is not changeable in either
SimCity 2000 or SCURK.

When you import graphics from another program, SCURK
will do its best to match each color in the imported graphic
to a color in the SimCity 2000 palette. This might work
perfectly—or it might leave some colors looking strange. You
can touch up the colors you don’t like, or leave them alone
and call it art. Your Sims won’t care one whit either way.

Paint the Town
Notes and
Guidelines
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If you want to use another paint program to draw or put the
finishing touches on objects, it’s best to use the right palette.
You can do this by first exporting an object with Export
BMP... (Windows) in the File menu, then loading that file into
your other paint program. The palette is usually included in
the exported file. Most paint programs will also let you copy
the palette from another file, so you can get the correct
palette for your other program from the sample BMP file. In
any event, even with the right palette, the color cycling won’t
appear in your other paint program, and you might use the
cycle colors by accident. The best thing to do is to start
objects in SCURK, export them for detailed touch-up in
another program (if you have one you really really like), then
bring it back into SCURK for final color test and touch-up.

OBJECTS AND THE SIMCITY 2000 SIMULATION

• You can make any of the buildings look any way you
want, but remember that each of the buildings (and
other objects) has a specific meaning to the SimCity 2000
simulation. For the most part, the functions of all the
objects in the Specials, Power, Transport & Military and
Misc. Ground object groups are pretty obvious. But
you’ll need to take a little care when dealing with the
objects in the Residential, Commercial and Industrial
groups. Each of these buildings is selected by the
simulation and put into a SimCity 2000 zone based
primarily on population density, with minor variations
for land value.

• As a rule of thumb, any residential, commercial or
industrial building that has a 1 x 1 base size is low
density. A building with a 3 x 3 base size is high density.
Buildings with 2 x 2 base sizes are medium density (some
are low-medium and others high-medium).
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• Each object has two names. The Full Name that appears
in the Paint the Town title bar is similar to name that will
appear in SimCity 2000 in the Query windows. This is the
name that you can edit to suit your creative whims and
spelling abilities. More than one object may have the
same Full Name. The other name is a shortened version
that appears only in SCURK within the Object Selector to
help you pick the object you want to work on. Each
shortened name is different to help you tell objects
apart. This name also tells you how objects are used by
the simulation. In these shorter names, L=Large,
M=Medium and S=Small. Some of the animations in the
Animated I object group consist of multiple frames. Their
shortened names are labeled A, B, C, etc., to show their
frame order. The objects in the Animated II object group
show the object moving in different directions. Their
shortened names indicate their direction: N=facing north
(up), E=facing east, NE=facing northeast, SE=facing
southeast, S=facing south. (When these objects need to
face the other directions, SimCity 2000 flips them.)

COPYING AND PASTING

• You can edit only one object at a time, but you can copy
and paste between different objects and groups within
different object sets. 

• You can only copy what is showing in the Drawing Area.
You cannot scroll through the drawing area while copy-
ing. Use Zoom Out to Copy large objects, including entire
buildings as long as they fit within the Drawing Area.

COLORS AND COLOR PALETTES

• As the “F” stands for “foreground,” the “B” in the color
palette stands for “background.” The letters “F” and “B”
simply distinguish between two colors which can both
exist in a texture pattern. It does not indicate such things
as the background of the drawing area for example, or
that one color is “in front” of or “behind” another. 
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• The foreground and background can be the same color.
When using the solid texture, the color of the brush is
always the “foreground” color.

• The colors in the palette and cycle patterns are fixed and
are not user alterable. Sorry.

• Regardless of how the color cycles “move” in the display,
cycle direction is determined by the order in which the
colors are placed on an object. For example, if color
number two of a pattern is placed above color one, and
color three is placed above color two, and so on,
“motion” is from bottom to top.

• Any steady color or color of a cycle pattern can be either
background or foreground for any texture pattern. Mix
and match color cycles, steady colors and textures for
truly garish effects.

See Appendix 2 for additional information on colors,
palettes and color cycling.

The Pick & Copy utility lets you mix and match objects from
the original object set, the future set and your own sets
(from Paint the Town) to create new object sets. You can
save them to disk and use them in SimCity 2000 to provide
your Sims with your own particular (or peculiar)
architectural interpretations.

As soon as you activate Pick & Copy, you’ll see one of the
screens on the next page. The DOS Object Selector has a
fixed size. The number of objects your Object Selectors show
in Windows will depend on your window size and the
resolution you are using. Your Object Set names may be
different: 

Pick & Copy

General
Information
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Source Object Set Name 

Information Line

Selector Arrows

Working Object
Selector

Working Object Set Name

Source Object
Selector

Active Object Group

Source File Name
and Path

Copy Buttons

Target Size Display

Forward 
Selector Arrow

Target Object
Selector

Target Name

Menu Bar

Source Object
Selector

Backward
Selector Arrow

DOS

WINDOWS
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The basic steps for using Pick and copy are: 

1. Pick a Source graphics set file. This can be the original
set, the future set or any set created in Paint the Town.

2. Pick a Target for the new set. A Target can be a new
graphics set, an existing graphics set file, or the SimCity
2000 program itself.

3. Copy objects, one-by-one or in groups, from the Source
to the Target. You can change Source files if you want to.
Select objects from a number of Sources.

4. Save the Target to disk as a graphics set or copy it into
SimCity 2000.

New Graphics Set creates a new, blank graphics set. Use this
option to make a new graphics set from parts of existing
graphics sets.

Existing Graphics Set lets you choose an existing graphics
set as your Target. Use this option to change a few objects or
groups in a graphics set.

SimCity 2000 selects SimCity 2000 as the Target. Use this
option to change some or all the graphics that will be used
when you next play SimCity 2000.

The basic steps for using Pick and copy are: 

1. Pick a Source Object Set. This can be the original set, the
future set, or any set created in Paint the Town.

2. Pick a Working Object Set to build. This could be the set
you most recently worked on in Paint the Town, (default)
any other existing object set, or a new, blank object set.

3. Copy objects, one-by-one or in groups from the source to
the working set. You can change the source object set if
you want to select objects from a number of sources.

DOS

DOS Targets

Windows
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4. Save the working set to disk. You can load a different working
set at any time to build a library of object sets. This Place &
Print screen lets you pick individual objects or object groups
in the Source set and copy them into the Working set. 

You always copy from the Source set to the Working or
Target set. Here s how:

1. Locate the object(s) in the Source set that you want to
copy to the Working or Target set.

Open the Object Group menu and select the object group that
contains the object(s) you want to copy. The same object
group is always displayed in both the Source and Working or
Target object selectors, even though the individual objects may
look different. Click on the Selector Arrows until the object you
want to copy is showing.

2. Select the object(s) that you want to copy to the
Working or Target set.

Click on the object or objects in the Source Object selec-
tor that you want to copy. Both the Source and Working
or Target instances of the object(s) will be highlighted.
Hold the Ctrl key (for Windows) and click on multiple
objects to select them. Hold the Shift key and drag your
mouse across a row of objects to select them. To de-
select an object, click on it again (in DOS), hold the Ctrl
key and click on it (in Windows).

3. Copy the Selected Object(s).

Open the Edit menu and choose either Copy Selected (in
DOS) or Copy All, (in Windows), or drag the highlighted
objects from the Source set to the Working set. DOS
users can also click on Copy Selected Object(s). SCURK
will automatically put selected objects from the 

Pick & Copy
Notes and
Guidelines
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Source set in their proper place within the Working set.
You’ll get a dialog box confirming what you want to copy. 

After objects are copied, they are de-selected.

4. Select another Source and repeat.

If you want your Working or Target set to include
individual objects from other Source files, then open the
File menu, select Load Source... or Open Source File...
and select the new Source file. Repeat steps one through
three until your Working or Target set is complete.

Copying entire Object Groups is very similar to copying
individual objects. Just follow these steps:

1. Select the object group you want to copy from the
Source set to the Working or Target set.

Open the Object Group menu and select the group you
want to copy. Select All Objects if you want to copy the
entire object set from the Source set to the Working set.

2. Click the Copy Object Group button in DOS, or Open
the Edit menu and select Copy All in Windows.

The selected object group will be copied from the
Source set to the Working or Target set. If you choose All
from the Object Group menu, the entire Source Object
Set will be copied. You’ll be asked to confirm your
action. 

3. Select another Source and repeat.

If you want your Working or Target set to include object
groups from other Source files, then open the File menu,
select Load and then Source..., and load a new source
object set. Repeat steps one and two until your Target or
Working set is complete.

Save your new (and improved) Target or Working set to the
disk like this:
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In DOS, open the File menu and select Save Target (to update
an old set) or Save Target As... (to create a new set). If you
have made SimCity 2000 your Target, then you also have the
option Copy to SimCity 2000. If you chose this option, then
your artwork will be used by your Sims the next time you
start SimCity 2000.

In Windows, open the File menu and select Save (to update
an old set) or Save As... (to create a new set), then select
Working Object Set from the submenu. You’ll be able to load
your artwork as an alternate graphic set the next time you
start SimCity 2000.

PICK AND COPY GUIDELINES
You can only copy objects from the Source Object Set to the
Working Object Set (or the Target set in DOS). You cannot
copy objects to the Source set. Any object set can be either
Source or Working. You can even use the same set as both
the Source and the Working or Target. 

You can only copy from a particular Source object to the
same particular in the Working or Target set. No matter how
you drag highlighted objects, Pick & Copy will always copy
the Source objects you have selected to their proper place in
the Working or Target set.

Nothing you do has any effect on the Source Object Set. You
cannot copy objects to the set you have loaded as the
Source set, nor can you save the Source set. If you want to
make changes to an object set, it must be loaded as the
Working or Target set. 
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FILE MENU
Open Source Graphics Set...—Opens a dialog box so you can
select a graphics set as the Source set.

Change Target—Opens a dialog box so you can select either
New Graphics Set, Existing Graphics Set or SimCity 2000 as
the Pick & Copy Target. 

Save Target—Saves the current Target graphics set to disk.
The original and future graphics sets are protected. If they
are chosen as your Target, you’ll have to rename them as
you save them.

Save Target As...—Allows you to rename or relocate the
Target graphics set as you save it. The original and future
graphics sets are protected. If they are chosen as your
Target, you’ll have to rename them as you save them.

Copy to SimCity 2000—Copies the current Target graphics
set into the SimCity 2000 game. The graphics will appear in
the game the next time you play it. This option is only
available if you have chosen SimCity 2000 as the Target in
the Choose Target dialog box.

Main Screen—Returns you to the SCURK Main Screen.

Quit—Returns you to the DOS prompt.

OBJECT GROUP MENU
This menu lets you select a group of objects from the
currently loaded object set (including new or blank sets).
The selected group will appear in the Object Selector.

TARGET SIZE DISPLAY
This displays how much larger or smaller the current Target
graphics set is compared to the original graphics set. The
display is updated each time you use the Copy Selected
Objects or Copy Object Group buttons. 

The Pick &
Copy Menu Bar

DOS
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This display is meaningful if memory is tight. If you have 8
MB of RAM, your graphic set can be 4 MB before you have
any problems—plenty big enough for most art work.
Additional RAM allows correspondingly larger graphics sets.

If your Target size is too large, you can still save it to disk,
and even copy it into SimCity 2000. But SimCity 2000 won’t
run on your computer if you don’t have enough memory.

The SCURK utilities share many of the same menus and
menu functions. Each utility also has some menu items
which are unique to that utility. Here’s a list of the Pick &
Copy Menu items and what they do:

FILE MENU
Load has three submenu items:

City...—Loads a previously saved city terrain for use in
Place & Print.

Source Object Set...—Loads a source object set for use
in Pick & Copy.

Working Object Set...—Loads the Working Object Set
used by the three SCURK utilities.

Save has two submenu items:

City—Saves the city terrain used by Place & Print under
its current name and path.

Working Object Set—Saves the Working Object Set
under its current name and path.

Save As has two submenu items:

City...—Lets you change the name or path (or both) of
the city terrain used by Place & Print.

Working Object Set...—Lets you change the name or
path (or both) of the Working Object Set.

Windows
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New has two submenu items:

City—Loads an unnamed, blank, flat city terrain for use
in Place & Print.

Working Object Set—Loads the original object set as the
Working Object Set.

Print Setup...—Opens a standard dialog box that allows you
to change certain aspects of how your printer will function.

Print City...—Opens a dialog box that allows you to print
some or all of the city that is loaded in Place & Print.

Exit—Closes SCURK (after prompting you to save any
changes you made).

EDIT MENU
Copy Selected—Copies all the objects you have selected
from the Source Object Set to the Working Object Set.

Copy All—Copies the entire group of objects that you have
loaded from the Source Object Set to the Working Object Set.
If you selected “All” from the Object Group menu, then the
entire object set will be copied from the Source to the
Working Object Set.

OBJECT GROUP MENU
This menu lets you select a group of objects from the
currently loaded object set (including new or blank sets).
The selected group will appear in the Object Selector.

WINDOW MENU
Cascade—Overlaps the SCURK utility windows. Click the title
bar of the utility you wish to use to activate that utility.

Paint the Town—Activates the Paint the Town utility.

Pick & Copy—Activates the Pick & Copy utility.
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Place & Print—Activates the Place & Print utility.

INFORMATION LINE IN WINDOWS
Below the Windows object selector is the Information Line.
This area provides a brief explanation of the highlighted
Menu item. 

Place & Print has two functions:

• It allows you to completely model a city’s terrain, and
provide buildings, infrastructure and all that other city
stuff without the annoying money, time and population
constraints of SimCity 2000.

• It prints part or all of your city in any of three sizes, in
color or black and white.

Big Big Warning!! Place & Print gives you complete
freedom to place any road, zone, building, object or
whatever anywhere you want—BUT once you load
your creation into SimCity 2000, don’t be surprised
when the buildings you so carefully placed start to
decay or disappear. Place & Print leaves you open to
explore beautiful and impossible cities and print them
out, but it doesn’t convince the Sims to like them.
(That’s controlled by the SimCity 2000 simulation and
is not changed by SCURK.) But Place & Print serves
another purpose: 

Beyond designing impossible cities (and customizing
possible ones) it will let you create the playfields for
future Maxis games, including driving and flying
simulations and...well, just wait and see.

When you first enter Place & Print (and if you haven’t
already loaded a city), the terrain is completely empty and
flat, ready to be molded to suit your fancy. You can leave it
flat for maximum city size, or sculpt it with the Edit tools.
You can also load cities created with either SCURK or
SimCity 2000.

Place &
Print

General
Information
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Object Selector

Status Area

View Tools

Work Area

Edit Tools

Menu Bar

Object Selector

Work Area

Information Line

Toolbox

Menu Bar

Title Bar

WINDOWS

DOS
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Note: The graphics displayed in Place & Print are
those currently loaded as the Working Object Set. To
change the graphics for placing or printing, simply
open the File menu, select Load and then select
Working.

The Place & Print Object Selector lets you choose and place
individual objects (buildings, parks and the like) anywhere
you want in the city. To use it:

1. Open the Object Group menu and select a group of
Objects (the default is Residential for DOS, and All
Objects for Windows).

2. Click on either arrow in the Object Selector until you see
the object that you want to place.

3. Click on that object to select it.

4. Click in the Work Area to place the object.

The Windows Place & Print Object Selector is movable so
you can move it out of your way and view more of your city
when you are building.

The Place & Print Tools are very similar to their
counterparts in SimCity 2000, with just a few differences:

• If a tool button has several functions, then click and hold
or click twice (DOS) or double-click (Windows) to open a
submenu of additional functions.

• Water (ponds, rivers, lakes) and water pipes are selected
with the Water tool.

• All zones, including seaports, airports and military, are
selected with the Zone tool. 

The Tools

The Object
Selector
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• Every object—except those in Animated I and Animated
II—that you can modify in SCURK (including trees, power
plants, bus depots, rail and subway stations, schools,
police and fire stations, etc.) is in a group, and is chosen
from the Object Selector.

Note: The Terrain toolbox in SimCity 2000 has more
extensive terrain modification tools. If you need more
earth-moving power than SCURK has, then, in SimCity
2000, select Edit New Map from either the Startup
dialog box or the File menu, make all the major
modifications you want, and save it to disk. You can
then load it into SCURK for adding city infrastructure
and objects.

BULLDOZER
The Bulldozer is your main tool for molding the land as well
as a source of destructive delight. Click once to use the most
previously used function. Click again for a submenu of these
functions: 

Demolish/Clear is the default function. It destroys and
removes objects without altering terrain or zoning
status. Click on anything to destroy it. The Place & Print
Bulldozer does not leave rubble.

Rotate Clockwise

Power Line Tool

Water Tool

Zone Tool

Rail Tool

Zoom Out

Bulldozer

Road Tool

Rotate Counter-Clockwise

Show Buildings Show Infrastructure

Show Underground View

Zoom In

Center Tool

Show Signs Show Zones
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Level Terrain lets you choose an altitude level. Click on
terrain with the altitude you want, then move the mouse
(without releasing the mouse button) to slice off hills
and fill valleys to the chosen height. When terrain is
leveled, any objects on that terrain are removed.

Raise Terrain lets you build hills, mountains and
plateaus. When terrain is raised, any objects built on that
terrain are removed.

Lower Terrain lets you dig canyons and remove
mountains. When terrain is lowered, any objects built on
that terrain are removed. If you lower the terrain below
sea level, it will fill with water.

De-zone lets you change undeveloped residential,
commercial, industrial, seaport and airport zones to
unzoned land. Developed zones are unaffected.

WATER TOOL
The Water tool lets you place water on the terrain and water
pipes underground. Click once to use the most previously
used function. Click and hold or double click (DOS) or click
twice for this submenu of options:

Pond/Lake/River lets you “paint” water on your terrain.
Use it to place lakes, rivers, coastal areas and water falls.
The cursor is a water drop when this function is active.
The Pond/Lake/River option does not lower terrain.

Pipes lets you place underground water pipes. Choosing
this option automatically changes the Work Area to the
Underground view so you can see where your pipes are
going. Your cursor is a water faucet when this function is
chosen.

Note: The Water Pump, Water Tower, Water Treatment
Plant and Desalinization Plant, which are part of the
SimCity 2000 water system, are placed with the Object
Selector. They are in the Specials group. 
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ZONE TOOL
The Zone tool lets you place nine zone types. Click and hold
or double click (DOS) or click twice to choose between these
types of zones: Light Residential, Dense Residential, Light
Commercial, Dense Commercial, Light Industrial, Dense
Industrial, Seaports, Airports and Military.

Note: All the Military airport and Seaport objects are
placed with the object Selector, and are in the
Transport & Military Group.

ROAD TOOL
The Road tool lets you place roads and related functions.
Click and hold, or double click (DOS), or click twice to chose
between Road, Highway, Tunnel and Onramp.

Note: The Bus Depot, which is part of the Road tool in
SimCity 2000, is placed with the Object Selector. It is in
the Transport & Military group. 

RAIL TOOL
The Rail tool lets you place rails and related functions. Click
and hold, or double click (DOS) or click twice chose between
Rail, Subway and Subway to Rail connections.

Note: The Rail Station and the Subway Station, which
are part of the Rail tool in SimCity 2000, are placed
with the Object Selector. They are in the Transport &
Military group. 

POWER LINE TOOL
The Power Line tool lets you paint power lines. There is no
submenu.

Note: Power Plants, which are part of the Power tool in
SimCity 2000, are placed with the Object Selector.
They are in the Power group.

ROTATE COUNTER-CLOCKWISE
Click to rotate the entire city map 90 degrees counter-
clockwise.
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ROTATE CLOCKWISE
Click to rotate the entire city map 90 degrees clockwise.

ZOOM OUT
Click to “step back” for a big picture look at your city.

ZOOM IN
Click to move in for a detailed look at your city.

CENTER TOOL
The Center tool lets you pick a place in your city to be
centered in the Work Area. Activate the tool and click
anywhere in the Work Area.

SHOW UNDERGROUND VIEW
Click to toggle between the surface and the underground
views.

SHOW BUILDINGS
Click to toggle on and off the display of all buildings in the
Work Area. The buildings won’t be destroyed, they’ll just be
invisible until you turn them back on.

SHOW INFRASTRUCTURE
Click to toggle on and off the display of all Miscellaneous
Ground Objects, plus power lines, roads and highways, rail
lines and subway stations.

SHOW SIGNS
Click to toggle on and off the display of all signs in the Work
Area.

SHOW ZONES
Click to toggle on and off the display of most buildings. It
doesn’t affect arcologies or city-owned buildings like police
and fire stations, educational facilities, depots or power
plants, but it does affect ports and military bases. In
underground view, it toggles on and off a color display that
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lets you know where your zones are without going back
upstairs.

FILE MENU
New City—Starts all over again with clear, flat terrain.

Open City...—Loads a previously saved city.

Save City—Updates the currently loaded city to disk under
the same name and in the same place where it was last
saved.

Save City As...—Opens a dialog box that lets you name or
rename your work, and choose the disk and directory where
you want to save it.

Export PCX—Opens a dialog box and lets you save the part
of the city that is showing in the Work Area (not the entire
city) as a graphic in the PCX format. 

Print Setup...—Brings up a dialog box so you can choose
from the a number of printer setting and default preferences. 

• Set Your Printer (or Compatible)—Click on the button
for the type of printer you have or one that your printer

is compatible with. If your printer isn’t listed
here, chances are that it is compatible with
at least one of these choices. Check your
printer manual for compatibility information.
The choices are: LaserJet, PostScript,
DeskJet Color, Epson 8-pin and Epson 24-pin.
(If you have a monochrome DeskJet, try the
LaserJet setting. It should work on some of
them, but not all.)

Warning: Choosing the wrong type of
printer can waste a lot of time and paper!

The Menus
DOS
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• Quality—Select either Low, Medium or High for printed
resolution. In most cases, the higher the resolution, the
longer something will take to print. If you have a really
nice city, it might be worth the wait.

• Contrast—Click the plus or minus buttons to increase or
decrease the contrast. Increasing the contrast makes
darker areas darker and lighter areas lighter. Decreasing
the contrast makes darker areas lighter and lighter areas
darker. The default setting of 0 is neutral. You can adjust
the contrast as high as +100 and as low as -100.

• Lightness—Click the plus or minus buttons to increase or
decrease the lightness of your printouts. Lightening may
save you printer toner and make dark areas clearer. You
can adjust the lightness as high as +99 and as low as -99.

• Print To—Click on the port that your printer is hooked
to. Most people have their printers hooked to LPT1. You
can also choose to print to a disk file that can later be
sent to your printer or taken to work or a friend’s house
to print on a better printer.

• Configuration File—Click Save to save the printer
settings (in the printer configuration file).
Click Cancel to close the Print Setup dialog
box without saving any changes you have
made.

Print...—Opens a dialog box that allows you to
print some or all of your city. Choose your zoom
level from the City Scale options, then click the
cursor on the small city map to select how much
of your city you want to print. You can also
override your default print settings.

• The City Map displays your entire city. The
cursor, when over the map, becomes a rect-
angle the size of one printed page. The larger
the City Scale, the smaller the page size will
appear. Click or click and drag over the part of
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the city you want to print. Numbered pages will be
displayed.

• City Scale determines the size of the city to print—Large,
Medium or Small. You can print any of the three basic
zoom sizes that you see in SimCity 2000. It is not based
on the zoom level in the Place & Print Work Area. 

• Quality—Lets you override the settings in the Print
Setup configuration file. Select either Low, Medium or
High final printed resolution. In most cases, the higher
the resolution, the longer something will take to print.

• Contrast—Lets you override the settings in the Print
Setup configuration file. You can set the contrast in
increments of ten between -100% and +100%. Positive
numbers make light areas lighter and dark areas darker.
Negative numbers make light areas darker and dark
areas lighter.

• Lightness—Lets you override the settings in the Print
Setup configuration file. Set this value to any whole
number between -99 and +99 to decrease or increase the
overall lightness of your print.

• Print To—Lets you choose (click on) the port that your
printer is hooked to. Most people have their printers
hooked to LPT1. You can also choose to print to a disk
file that can later be sent to your printer or taken to work
or a friend’s house to print on a better printer.

Note: A file printed to a hard drive can take up 16 MB
or more on your hard drive, depending on the settings
and how much of your city you print.

• Start Printing—Prints the area of the city you have
defined in the City Map when you click Selected, and
prints the entire map when you click on Entire Map.
Printing begins as soon as you click either button. Click
Cancel to close the Print dialog box without printing. 

Note: Printing an entire city can take as long as five
hours, depending on Quality and City Scale settings.
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Main Screen—Returns you to the SCURK Main Screen.

Quit—Returns you to the DOS prompt.

OBJECT GROUP MENU
The Object Group menu lets you choose the group which has
the objects you want to place. Any modifications you have
made to objects in Animated I or Animated II groups will be
used in SimCity 2000, but you can’t place them in Place &
Print.

STATUS AREA
Red text here tells you which tool is active while your cursor
is in the Work Area.

The SCURK utilities share the same information and many of
the same menus and menu functions. Each utility also has
some menu items that are unique to that utility. Here’s a list
of the Place & Print menu items and what they do:

FILE MENU
Load has three submenu items:

City...—Loads a previously saved city terrain for use in
Place & Print.

Source Object Set...—Loads a Source Object Set for use
in Pick & Copy.

Working Object Set...—Loads a Working Object Set for
use in all three SCURK utilities.

Save has two submenu items:

City—Saves the city terrain used by Place & Print under
its current name and path.

Working Object Set—Saves the Working Object Set
under its current name and path.

Windows
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Save As has two submenu items:

City...—Lets you change the name or path (or both) of
the city terrain used by Place & Print.

Working Object Set...—Lets you change the name or
path (or both) of the Working Object Set.

New has two submenu items:

City—Loads an unnamed, blank, flat city terrain for use
in Place & Print.

Working Object Set—Loads a clean, unblemished copy
of the original set as the Working Object Set.

Export City...—Exports the city in the Work Area as a BMP
file (for Windows).

Print Setup...—Opens a system standard dialog box which
allows you to change certain aspects of how your printer will
function. Consult your computer and printer manuals if you
need help with changing any settings. 

Print City...—Opens a dialog box that allows you to print
some or all of your city. Choose your
zoom level from the Magnification
options then select the pages you want
to print. You can also make changes to
your printer setup  if necessary.

• The City Map displays an entire
city area. You won’t see any
features such as mountains, coasts
or buildings, but the map itself is
positioned the same way as your
city terrain in the Place & Print
Work Area. The numbered
rectangles indicate what part of
the city will be printed on one
page of paper. The larger the
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magnification level, the smaller the page size and the
more detail each page will have. Click on pages you don’t
want to print to make them “gray.”  Click on any of those
pages again if you want to print them.

• Magnification determines the size of city to print. The
“1x” option prints pages in the farthest Zoom Out mode,
“2x” is the medium view, and “4x” is the closest Zoom In
mode. This magnification level is not based on the zoom
level you are using in the Place & Print Work Area.

• Print What gives you the choice of printing the Entire
Map or the pages you have Selected. If you select Entire
Map, you can’t “turn off” any pages.

• The Print button prints the area of the city you have
defined in the City Map, either the Entire  Map, or
Selected pages.

• The Setup button opens a standard print setup dialog
box. You can change several options of printing from this
dialog box. For best results, you should use Portrait
Orientation and 8 1/2 x 11 in.

• The Cancel button closes the print dialog box and returns
you to the Place & Print Work Area without printing.

• The Help button opens the Help file if you need assistance.

Note: Printing an entire city can take as long as five
hours, depending on the Magnification Setting.

Exit—Closes SCURK (after prompting you to save any
changes you made).
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OBJECT GROUP MENU
The Object Group menu lets you choose the group which has
the objects you want to place. The groups Animated I and
Animated II are missing from this menu list. Any
modifications you have made to objects in Animated I or
Animated II groups will be used in SimCity 2000, but you
can’t place them in Place & Print.

WINDOW MENU
Cascade—Overlaps the SCURK utility windows. Click the title
bar of the utility you wish to use to activate that utility.

Paint the Town—Activates the Paint the Town utility.

Pick & Copy—Activates the Pick & Copy utility.

Place & Print—Activates the Place & Print utility.

INFORMATION LINE
This area provides a brief explanation of the highlighted
Menu item.

SCURK  4/10/98 1:28 PM  Page 48



Page 49

REGULATIONS FOR CITY PLANNERS

• All SimCity 2000 Edge-of-the-World restrictions and
Terrain type and size requirements are in effect in Place
& Print. Objects that cannot go on the edge of the map in
SimCity 2000 cannot be placed there in Place & Print; all
objects require their specific base tile size to be flat
terrain; the Marina must be placed on at least one water
tile; Onramps must still be at proper intersections of
Road and Highway; Subway to Rail connections require
at least one Rail, a Subway, or another Subway to Rail
connection. Power Plants don’t grow old in SCURK.

• Zoning does not affect where you can place objects. For
example, if you place a residential building in an
industrial zone, the land under the residential building
will be rezoned residential.

• You can load your old cities and renovate to your heart’s
content. Any and all renovations do not take effect until
the next time you load your city into SimCity 2000.

• You can’t alter scenarios. Sorry, you’ll have to beat those
on your own.

• There is no rubble when you demolish something, but
you can place rubble anywhere you want, if you want.

• You can’t add money to your city’s treasury. (Who needs
money now, anyway?)

Place & Print
Notes and
Guidelines
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IF YOU BUILD IT, WILL THEY COME?
Any city you create with Place & Print can, of course, be
loaded into SimCity 2000. Be forewarned though. The second
you load it into SimCity 2000, the simulation will start to
change things according to the whims of the Sims. A city you
“pre-build” with Place & Print will experience an initial spurt
of growth when loaded into SimCity 2000. The larger your
city, the sooner this growth will end. The first Sims who
move in occupy only a few of the buildings you’ve provided.
All the rest of the buildings are considered abandoned. Office
towers sit vacant as they wait for tenants who are slow in
coming. Houses are unbought and apartments are unrented.
There are no workers for the factories. Finally, Power Plants
you placed in SCURK reach the end of their life cycle. Urban
blight spreads quickly, which is hardly a selling point for
enticing more Sims to move to your city. 

The main “practical” and productive uses for the Place part
of Place & Print are:

• To modify, customize or otherwise touch up cities that
you’ve built in SimCity 2000

• To create cities-as-art to print out 

• To see just how well you understand city design and the
SimCity 2000 simulator by building a city first and seeing
if the Sims like it

• To create the playfields for future Maxis driving, flying
and other games and simulations
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IntroductionA SCURK Tutorial
In this brief tutorial, we’ll touch on the basic features of each
of the three SCURK utilities. We will:

• Start Paint the Town and modify one object (the Statue)
with the paint tools and color cycling.

• Use Pick & Copy to put some different graphics into the
SimCity 2000 game.

• Use Place & Print to make a small city—with our new
statue and graphics—and print it out.

In this tutorial, when you see type that looks like this, it is an
instruction for you to follow.

Type that looks like this is an explanation.

By the way, this tutorial assumes that you are familiar with
SimCity 2000. If you aren’t, take some time and play the
game, then come back to SCURK and this tutorial. It’ll make a
lot more sense if you do.
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This first part of the tutorial will walk you through the basics
of using the Paint the Town utility. Here’s what we’re going
to do:

• Start Paint the Town.

• Locate a particular object (the statue).

• Modify the object (put a couple of pigeons on top of it,
then snazz it up with color cycling).

• Save the modified object for later use.

Load SCURK.

Activate Paint the Town.

Expand the utility to its full size if necessary.

When you first enter Paint the Town, you’ll see one of the
following screens:

Using Paint
the Town

DOS

Palette

Toolbox

Drawing Area

View Windows

Object Selector
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You’ll want to draw your own buildings eventually, but for
now we’ll use the original graphics as a base. By default, you
start with a blank set under DOS, or the original set of
objects in Windows.

DOS users: Open the File menu and select Open....

Click on original.til in the Select Graphics Set File dialog
box, then click the Open button.

LOCATING THE STATUE
When an object set is loaded, the “Large Apartments” object
of the Residential Group is the default starting point. We
want the Statue, which is in a different object group—
Specials.

Palette

Toolbox

Working Area

View Windows

Object Selector

WINDOWS

SCURK  4/10/98 1:28 PM  Page 53



SimCity 2000 Urban Renewal Kit — TutorialPage 54

Open the Object Group menu and select Specials.

You’ll now see that the Object Selector looks like this:

The Statue won’t be very hard to find.

Click on either selector arrow until you see the Statue in the
Object Selector.

Click on the Statue.

DOS

WINDOWS

DOS WINDOWS
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Now the Statue is ready for enhancement.

FOR THE BIRDS—OUR FIRST DRAWING
We’ll zoom in close and work at the “pixel” level to see what
we’re doing, just like the artists did when the statue was first
drawn. 

Click the Zoom In tool until it is “ghosted” and you are zoomed
all the way in.

Move the right-side scroll bar up until just the top of the Statue’s
head shows.

Note: The Statue in the Drawing area will lose some
definition, but the three View screens will not change.

We could draw our pigeon directly on the Statue, but it’ll be
easier to draw it above the statue first, in case we make
mistakes or have to erase
something. We can copy it and
move it down when we’re sure
we have it right.

In DOS, click and hold on any
color of the sample palette
to open the entire palette. 

Click on one of the gray
colors of the color palette.

An “F” (for foreground)
appears in the palette on
the color you chose. This
color is also the color in
the Brush Color Box.

Click the Free Drawing tool (if it isn’t already selected). 

Gray color area

DOS

WINDOWS

Gray color area
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Click the smallest brush size (if it isn’t already selected).

Make sure you are using the Solid texture. 

Here’s the pigeon we’re going to create (it’s a simple bird,
consisting of only seven pixels):

Draw a pigeon in the space above the Statue, like the one in the
picture. 

The sample uses white and two shades of gray, but you can
use as few or many shades or colors as you want. Just find
the color(s) you want to use in the palette, click on them
(one at a time) and draw with them. 

Note: If you draw something that is erased by the
editor, it means you are outside the Clip Region. If this
happens, make sure the bottom scroll bar is near the
center of the bar and try drawing the pigeon lower
down, closer to the Statue’s head.

Smallest Brush

Solid Texture

DOS

WINDOWS

Smallest Brush

Solid Texture
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COPYING, PASTING AND ERASING
Now we’ll use the Copy tool to place our work of art on the
Statue.

Click the Copy tool.

Move the cursor slightly above and to the left of your bird.

Click and hold the left mouse button, and drag the cursor down
and right to stretch a box around your bird.

Release the mouse button.

Your cursor becomes a brush in the shape, size and color of
our feathered friend. When you move the cursor outside the
drawing area, it becomes a normal arrow again. In DOS, a red
“COPY” appears in the Status line to remind you that a copy
is stored in memory.

Use the scroll or slider bars to bring the Statue back into the
Drawing Area.

Position your bird-cursor to one shoulder of the Statue like in the
top picture at the right.

Click the mouse to paste a copy of your bird onto the Statue.

Anyone who has seen pigeons knows that there is never just
one. However, we won’t have to draw another one. We can
flip our drawing in the clipboard to make a new image.

Open the Edit menu.

Choose Flip Horiz or Flip Copy Horiz to make your pigeon-cursor
change direction.

Move the cursor to the Statue’s head like in the bottom picture at
the right.

Click to paste another bird, this time on the Statue’s head.

Next, we’ll remove our initial pigeon, since we don’t want it
as part of our object.
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Use the scroll or slide bars to bring the initial pigeon back into
the Drawing Area.

Click the Erase tool.

Put the “eraser” end of the cursor on each dot of the test bird,
and click to remove that dot.

SAVING YOUR WORK
Now we’re ready to save our work for later use. We don’t
save just the Statue. We must save the Statue as part of a
new Object Set.

In DOS, open the file menu and choose Save As...

Note: Remember, you must name the graphics set
before you can save it–you won’t be allowed to over-
write the original set of graphics.

In Windows open the File menu and choose Save As..., then
choose Working Object Group. This will open a standard dialog
box for saving files.

Type the word “Tutorial” in the file name box.

ADDING PANACHE WITH COLOR CYCLING
SimCity 2000 uses color cycling to create a sense of motion
and activity. Traffic, tornadoes, water flow, smoke from
factories—even the drive-in movie—are just a few of the
objects that use color cycling. See Appendix 2 for more
information on color cycling.

We’re going to do something a little more modest. We’ll use
color cycling to give the pedestal of our pigeon-covered Statue
some eye-catching lights. Here’s what we’re going to do:
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• Zoom in to the base of the statue

• Choose a color cycle pattern

• Draw our flashing lights

Click the Zoom In tool to get as close in as you can,
then zoom out one level.

Use the Drawing Area scroll or slider bars to bring
the left side of the pedestal to the center of the
Drawing Area as pictured.

The numbered squares in the picture above are
where we will add our color-cycling lights.

First, let’s change our brush size.

Click the next-to-smallest brush size, then click the Free Drawing
tool.

Note: Since our brush size is larger, it might be a tad
more difficult to position the brush properly. Use the
Undo option from the Edit menu if you put a dot in the
wrong place.

Now let’s get our color cycle pattern. 

IF YOU’RE IN DOS 

Click and hold on the Color Cycle Palette to open the eleven
color cycle patterns.

Click the top color of the four-color “red-yellow-brown-brown”
cycle pattern. (The sixth from the left in the Color Cycle Palette.)

The selected color cycle pattern is now
displayed on the left side of the sample palette.

IF YOU’RE IN WINDOWS

The color cycles are all gathered together at
the bottom of the Color Palette.

Scroll the color palette until you see the color
cycle patterns.

Square One
Square Two

Square Three
Square Four
Square Five
Square Six

Square Seven

The red-yellow-brown-brown cycle
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Click the first color of the four-color “red-yellow-
brown-brown” cycle pattern.

URBAN RENEWAL WITH FLASH

Place the brush in the center of square one and
click to place your first flashing dot.

Click the second color of the
pattern in the Color Cycle
Display. 

Click on square two to place
your second flashing dot.

Click the third color of the
pattern, and place this color
in square three.

Choose the fourth color of
the pattern, and put it in
square four.

We’re at the end of the pattern, but we still have more
squares to work on. To make a cycle which is longer than the
length of the pattern, start the pattern over with the first
color.

Click the first color of the pattern, and place this color in square
five.

Put the second color of the pattern in the square
six.

Finally, put the third color of the pattern in
square seven.

Now we have a lovely set of running lights
along the base of the statue. 

All we need to do now is save our work and
we’re ready for the next step.

Open the File menu and select Save, and in
Windows, choose Working Object Set.

The red-yellow-brown-brown cycle

First color in cycle pattern selected

DOS

WINDOWS 
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In this part of the tutorial, we’ll:

• Start the Pick & Copy utility.

• Load in the graphics set we saved with the modified
Statue.

• Copy the Statue into the SimCity 2000 game.

Click the Pick & Copy button in the Main Screen.

You are first asked to select a Source Graphic Set. In our
case, this is the file we saved with our new Statue graphics.

Open the Tutorial graphics set.

Next, you are asked to choose a Target. We want our Target
to be the SimCity 2000 program so our new Statue will show
up the next time we play.

Click on SimCity 2000.

The Pick & Copy screen will now open. 

At the top of the screen are objects from
our source graphics set (Tutorial), and at
the bottom are the equivalent objects
that are currently in the SimCity 2000
game. 

The Residential Group is the default
active group. Our Statue is in Specials, so
we need to load the Specials object
group.

Open the Object Group Menu and select
Specials.

Click either Selector Arrow until the Statue
appears in the Selectors.

Click the Statue in either Selector.

Using Pick &
Copy
DOS
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The Statue in both the Source and the
Target Selectors is now active. The
Source Statue has flashing lights and
some pigeons. The Target Statue is
staid and bird free.

Now we copy our handiwork.

Click the Copy Selected Object(s) button.

Our Source Statue is copied to the
Target Statue. The Source Statue is
unchanged, while the Target Statue is
much more energized.

The only thing left to do is save the Target so that SimCity
2000 can use our Statue.

Open the File menu and select Copy to SimCity 2000.

When prompted, choose Yes to Overwrite the existing file.

That’s all there is to it. Your new Statue is the one that will
be on display next time it appears in SimCity 2000. You can
also use it in the Place & Print tutorial.

Open the File menu and select Main Screen.

Statue selected
in both Source
and Target
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In this part of the tutorial, we’ll:

• Start the Pick & Copy utility.

• Pick some objects that have interesting graphics.

• Copy these graphics to another object set which we will
use in the SimCity 2000 game.

Click the Pick & Copy window grow box
to expand Pick & Copy to the full size of
your screen.

The Statue we modified is already in
the Working set. In order to embellish it
further, we’ll use some graphics from
the Future graphics set.

Open the File menu and select Load....

Select the Source Object Set submenu
item.

Choose the Future Object set.

At the top of the screen are objects
from the source object set (Future), and at the bottom are
the equivalent objects of the Working Object Set.

Our statue would look best if it were
surrounded with a few municipal
buildings, such as a city hall and a
museum. These buildings are in the
Specials object group.

Open the Object Group menu and select
Specials.

Click either Selector Arrow until the Zoo
and Museum appear in the Selectors.

While holding down your Ctrl key, click
on the Museum, then the Zoo object in
the Source Object Set.

Using Pick &
Copy
Windows
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The Zoo and Museum objects in both the Source and the
Working Selectors are now active. Now we’ll build our
Working set by adding these new graphics to it.

Click and hold your mouse, and drag the selected objects to the
Working Object selector.

As soon as your mouse cursor enters the Working Object Set
selector, the Working objects which correspond to the
Source objects you selected will highlight. Don’t worry about
lining up the specific Source objects with the Working
objects. SCURK will make sure that the graphics are put in
their proper place. 

Release the mouse button to finalize the copying.

You’ll be asked to confirm that you want to copy the
Museum and Zoo tiles. Click the OK button. The future
graphics we selected are now a part of our working set. Of
course, since we have made a change to our Working set, we
should save our work again.

Open the File menu and select Save, then select Working Object
Set.

When prompted, choose Yes to Overwrite the existing file.

That’s all there is to it. These now objects are the ones your
Sims will use the next time you start SimCity 2000. But why
wait? Let’s put them to use in Place & Print.

Open the Windows menu and select Place & Print.

SCURK  4/10/98 1:28 PM  Page 64



Page 65

In this part of the tutorial, we’ll:

• Start the Place & Print utility,

• Build a tiny city that will display and the objects we
copied,

• Save our work as a city that can
be loaded into SimCity 2000,
and print it out.

In DOS: Click the Place & Print
button on the main screen.

We start with flat, blank terrain.

First, we’ll put down some roads—
the same way we would in SimCity
2000.

Click the Road tool in the toolbox.

Place some roads in the Work Area.

Now we’ll use the Object Selector to locate
some objects. Let’s get to the Specials section and find
our artwork.

Open the Object Group menu and select Specials.

Click on either of the Object Selector arrows until we see
our statue and any buildings we have copied.

Click on the Statue to select it, then place a few in the Work
Area along the roads.

Now let’s make them the centerpiece of a plaza. 

Note: To DOS users! In the DOS Pick & Copy
tutorial, only the statue was copied. You can load
the future set and add the zoo and museum to the
set with your statue, or use the original buildings.

Click on the Museum object and place one or two near the
statue.

Using Place &
Print

Toolbar Work Area

Object Selector
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Click on the Zoo object and place it near
the museums.

That’s all there is to using the Object
Selector: select the object group, select
the object, place the object in the Work
Area. Simple.

Obviously, this isn’t much of a city, so if
you want to spend some time adding
roads, modifying the terrain with the
Bulldozer tool and placing more objects,
go right ahead. We’ll wait here for you.
Come on back when you’re ready to

save the city to disk and print it out.

SAVING YOUR CITY

Now to save the city.

Open the File menu and select Save City.

This dialog box will open:

Type in a name for your city in the city name text box.

Click on your choice of Easy/Medium/Hard and the
Year.

Click on the Done button.

Our City is now saved and ready to load into SimCity
2000. Now let’s print it out.

Note: If you don’t have a printer hooked up to
your computer, you’ll want to skip this part
and jump ahead to the Farewell section.

SCURK  4/10/98 1:28 PM  Page 66



Page 67

PRINTING IN DOS: 

0pen the File menu and select Print Setup... to open the
Print Setup dialog box.

Click on the button under Set Your Printer which best matches
your printer.

Click on the button under Print To that tells which port your
printer is hooked to (usually it’s LPT1).

Click on Save to save this configuration.

Open the File menu and Select Print....

This opens the Print dialog box. The Print dialog box is
described in detail in the DOS Menu section of Paint the
Town. You can print your city in three sizes, matching the
three zoom levels in SimCity 2000. The Large size could take
over 20 pages to print an entire city. In Medium, you can
print your whole city in eight pages, and Small will fill two
pages.

Luckily, you don’t have to print the whole city. In fact,
Tutorial City is small enough to fit on one page in the Large
size. Let’s print it.

Click the Large button under City Scale.

Move your cursor (which is a rectangle the size of one page) over
the small city map, position it so it surrounds as much of the city
as possible, and click.

Click the Selected button at the bottom of the dialog box.

Printing will begin. This may take a while, depending on your
computer, your printer and the complexity of your city. If
you want to halt the printing process, press the Esc key. 

Printing one page is nice for a small city, but printing a larger
area is also easy. Just click and drag the page-sized cursor
across the part of the city you want to print. The pages will
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be marked and numbered. Don’t worry about overshooting
the map—any pages that are off the map won’t be printed.

Or if you want to print the whole city, don’t bother with the
map or the cursor at all. Just click on the Entire Map button
at the bottom of the Print dialog box.

PRINTING IN WINDOWS 

Open the File menu and select Print City... to open the Prints of
the City dialog box.

This opens the print dialog box. You can print your city in
three sizes, matching the three zoom levels in SimCity 2000.
The Large size (4x) could take over 20 pages to print a whole
city in the sharpest detail. In Medium (2x), you can print
your whole city in eight pages, and Small (1x) will fill two
pages, but you won’t see very much detail.

Luckily, you don’t have to print the entire city area. In fact,
the city we have made is small enough to fit on a few pages
in the Large size. Let’s print it.

Click the 4x Magnification option.

Click on the Selected button under “Print What.”

It may be a little hard to determine where your buildings are
on the city map. If you’ve put your Plaza near the center of
the map, you should turn “off” the pages near the edge so

you don’t have to wait for them to print.

Click the Print button.

Printing will begin. This may take a while,
depending on your computer, your printer
and the complexity of your city. If you
want to halt the printing process, press
the Esc key.
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Printing one page is nice for a small city, but printing a larger
area is also easy. Just click and drag the page-sized cursor
across the part of the city you want to print. The pages will
be marked and numbered. Don’t worry about overshooting
the map—any pages that are off the map won’t be printed.

Or if you want to print the whole city, don’t bother with the
map or the cursor at all. Just click on the Entire Map option.

SCURK  4/10/98 1:28 PM  Page 69



SimCity 2000 Urban Renewal Kit — TutorialPage 70

That’s it for the tutorial. You should now be able to use
SCURK and customize cities to your heart’s content. But if
you want more help or details, check out the rest of this
manual. It explains every button, tool and function, and has a
lot of helpful hints and tips that will make your time with
SCURK more fun and more efficient.

Happy SCURKing!

Farewell
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Appendix 1 :  Fi le Types
SCURK deals with a number of different file types. Here’s a
chart that explains what and where each file type is.

GRAPHICS SET FILES —*.TIL, *.MIF
This type of file contains the graphics for all of the objects
for SCURK or SimCity 2000. These files always end with .til in
DOS, and with .mif in Windows.

This type of file is what you are editing in the drawing area,
and is what you are manipulating when you select New,
Open..., Save or Save As... from the File menu.

PCX FILES —*.PCX 
This is a standard graphics file format that can be read and
written by most DOS- and Windows-based art programs.
These files always end with .pcx.

In Paint the Town, you can Import PCX files into the Import
window and copy parts of them to paste into the Drawing
Area. You can also export the object that is in the Drawing
Area to a PCX file that can be loaded into another paint
program. This exported file is just the one object that is in
the Drawing Area—not the whole graphics set.

GRAPHICS SET FILES —*.TIL, *.MIF 
This type of file contains the graphics for all of the objects
for SCURK or SimCity 2000. These files always end with .til in
DOS, and with .mif in Windows.

Fi le Types Found
In Paint the Town

File Types Found
In Pick & Copy

SCURK  4/10/98 1:28 PM  Page 71



SimCity 2000 Urban Renewal Kit — Appendix 1Page 72

The Source in Pick & Copy is always this type of file. You can
choose to have the Target be a graphics set, or the SimCity
2000 program. Even if you choose SimCity 2000 as the Target,
when you save the target, it is saved as a graphics set file.

SIMCITY.DAT—DOS ONLY
This is a special file that comes with SimCity 2000. It contains,
among other things, all the graphics for the program.

When you choose Copy to SimCity 2000 from the File menu,
SCURK copies the graphics in the Target into this file so the
next time you play SimCity 2000, you’ll see the new Target
graphics.

SIMCITY 2000 CITY FILES —*.SC2 
These are saved cities for and from SimCity 2000.

PCX FILES —*.PCX 
This is a standard graphics file format that can be read and
written by most DOS- and Windows-based art programs.
These files always end with .pcx.

In Place & Print, you can export the part of the city that is
currently showing in the Work Area—not the whole city—as
a PCX file that can be loaded into other paint programs.

Files that end with .til can be used in DOS or Windows
SimCity 2000 cities. Files that end in .mif can only be used in
Windows SimCity 2000 cities.

Fi le Types Found
In Place & Print
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Appendix 2:  Colors,  the
Palette and Color Cycling
These days, DOS and Windows all support thousands, if not
millions of possible colors, but these systems usually limit
the number of those colors that can appear on the screen at
a time. Most computer games these days support either 16
or 256 simultaneous colors.

The more colors you want to display at a time, the more
memory it requires to hold that information—that’s memory
in RAM, memory on the hard disk, and memory on the floppy
disks [or CD-ROMs] that the program comes on. In addition
to memory requirements (and the cost of the extra disk
space), displaying thousands or millions of colors at once
slows down the computer, because it has to move so much
more information around in memory and draw it on the
screen.

The palette is the set of all the colors available in a particular
program; it is chosen by the art director, with input from the
programmers. You can think of it as an electronic version of
the painter’s palette, where the artist mixes colors. What it
actually is, is a lookup table for the computer. It has one
column of numbers, from 0 to 15 for a 16-color palette or
from 0 to 255 in a 256-color palette. In another column are
the instructions for mixing that color out of red, green, and
blue (RGB).

Programmers don’t have to spell out the RGB formula for
each pixel (dot) drawn on the screen, they just say make this
pixel color 127, and the computer will look up the color on
the palette.
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The palette can be customized for each program and
changed while a program is running. If you change a color
definition in the palette, say change color 192 from blue to
red, then every instance of color 192 on the screen will
change from blue to red. This change happens very
quickly—much more quickly than having the computer
search every dot to find out which ones are color 192 and
changing them to another color—and takes very little CPU
time, so it doesn’t slow down the action in the game.

Color cycling is a technique that takes advantage of the
power, speed and flexibility of changing color definitions in
the palette to create effects or animations. SimCity 2000 uses
color cycling to create, among other things, the animations
of traffic on the road, the smoke from the factory smoke-
stacks and the flashing lights on the Title screen.
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